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Section : General English and Comprehension

Q.41 Select the option that can be used as a one-word substitute for the underlined

group of words.

There were lots of things we love about internet search, and it gives people

information and their time back because this is better, faster and more

productive of desired effects
Ans x 1.absorptive

x 2. itinerant
« 3. efficient

x 4. exulting

Q.42 Select the most appropriate option to fill in the blank.

Sheworea  dress to the party.
Ans x1.joyous
x 2. milky
x 3. utile

4. red

Q.43 Select the most appropriate option to fill in the blank.

He is studying hard __ he can pass the exam.
Ans 1. sothat
x 2. otherwise
x 3. therefore

x 4. because
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Q.44 Select the most appropriate ANTONYM of the given word.

Prolix

Ans 1. Concise
x 2. Melodic
x 3. Rigid

x 4. Fragrant

Q.45 Select the most appropriate meaning of the given idiom.

Drink like a fish
Ans x 1.0ne who is an important person but on an insignificant scale
% 2.0ne who is an important person in a small group
x 3. A matter or a situation that needs to be dealt with

« 4. When one tends to consume large quantity of alcoholic beverages
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Comprehension:

Read the given passage and answer the questions that follow.

Watching someone yawn often makes you yawn too—even reading about yawning can
trigger it. A new study suggests that contagious yawning is linked to empathy and social
bonding. Children don’t typically develop this behaviour until around age four, and those
with autism are about half as likely to yawn in response to others. In severe cases, they
may never do so. This discovery could help doctors diagnose developmental disorders and
better understand subtle human connections. Molly Helt, a clinical psychology graduate
student at the University of Connecticut, was inspired by her autistic son, who didn’t yawn
back when she tried to help him clear his ears during a flight. “Autistic kids might be
missing that unconscious emotional link,” she said. Helt emphasised that understanding
others’ minds is a key part of human development—a trait autistic individuals often
struggle with. Yawning, she suggests, may reflect a deeper instinct for emotional

connection.

SubQuestion No : 46

Q.46 What can be inferred about the role of yawning in human interaction, based on

the passage?
Ans x 1. Yawning is purely a physical response to lack of oxygen.
x 2. Yawning is more frequent in children with autism.
x 3. Yawning serves no social purpose in humans.

« 4. Yawning might be an unconscious tool for emotional connection.



https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap

Adda247

Comprehension:

Read the given passage and answer the questions that follow.

Watching someone yawn often makes you yawn too—even reading about yawning can
trigger it. A new study suggests that contagious yawning is linked to empathy and social
bonding. Children don’t typically develop this behaviour until around age four, and those
with autism are about half as likely to yawn in response to others. In severe cases, they
may never do so. This discovery could help doctors diagnose developmental disorders and
better understand subtle human connections. Molly Helt, a clinical psychology graduate
student at the University of Connecticut, was inspired by her autistic son, who didn’t yawn
back when she tried to help him clear his ears during a flight. “Autistic kids might be
missing that unconscious emotional link,” she said. Helt emphasised that understanding
others’ minds is a key part of human development—a trait autistic individuals often
struggle with. Yawning, she suggests, may reflect a deeper instinct for emotional

connection.

SubQuestion No : 47
Q.47 Which of the following would be the most appropriate title for the passage?
Ans x 1. New Techniques for Teaching Autistic Children to Yawn
% 2. Yawning and Sleep Patterns in Children
% 3. How to Stop Contagious Yawning in Public

« 4. The Surprising Link Between Yawning and Empathy
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Comprehension:

Read the given passage and answer the questions that follow.

Watching someone yawn often makes you yawn too—even reading about yawning can
trigger it. A new study suggests that contagious yawning is linked to empathy and social
bonding. Children don’t typically develop this behaviour until around age four, and those
with autism are about half as likely to yawn in response to others. In severe cases, they
may never do so. This discovery could help doctors diagnose developmental disorders and
better understand subtle human connections. Molly Helt, a clinical psychology graduate
student at the University of Connecticut, was inspired by her autistic son, who didn’t yawn
back when she tried to help him clear his ears during a flight. “Autistic kids might be
missing that unconscious emotional link,” she said. Helt emphasised that understanding
others’ minds is a key part of human development—a trait autistic individuals often
struggle with. Yawning, she suggests, may reflect a deeper instinct for emotional

connection.

SubQuestion No : 48

Q.48 According to the passage, at what age do children typically begin to show

contagious yawning behaviour?
Ans x 1. During teenage years
x 2. Around age two
« 3. Around age four

x 4. After age six
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Comprehension:

Read the given passage and answer the questions that follow.

Watching someone yawn often makes you yawn too—even reading about yawning can
trigger it. A new study suggests that contagious yawning is linked to empathy and social
bonding. Children don’t typically develop this behaviour until around age four, and those
with autism are about half as likely to yawn in response to others. In severe cases, they
may never do so. This discovery could help doctors diagnose developmental disorders and
better understand subtle human connections. Molly Helt, a clinical psychology graduate
student at the University of Connecticut, was inspired by her autistic son, who didn’t yawn
back when she tried to help him clear his ears during a flight. “Autistic kids might be
missing that unconscious emotional link,” she said. Helt emphasised that understanding
others’ minds is a key part of human development—a trait autistic individuals often
struggle with. Yawning, she suggests, may reflect a deeper instinct for emotional

connection.

SubQuestion No : 49
Q.49 What is the central theme of the passage?
Ans x 1. Yawning can be used as a teaching tool for children on airplanes.
x 2. Contagious yawning is a way to cure autism.
« 3. Yawning may be an indicator of empathy and social connection.

x 4. Children under the age of four yawn more often than adults.
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Comprehension:

Read the given passage and answer the questions that follow.

Watching someone yawn often makes you yawn too—even reading about yawning can
trigger it. A new study suggests that contagious yawning is linked to empathy and social
bonding. Children don’t typically develop this behaviour until around age four, and those
with autism are about half as likely to yawn in response to others. In severe cases, they
may never do so. This discovery could help doctors diagnose developmental disorders and
better understand subtle human connections. Molly Helt, a clinical psychology graduate
student at the University of Connecticut, was inspired by her autistic son, who didn’t yawn
back when she tried to help him clear his ears during a flight. “Autistic kids might be
missing that unconscious emotional link,” she said. Helt emphasised that understanding
others’ minds is a key part of human development—a trait autistic individuals often
struggle with. Yawning, she suggests, may reflect a deeper instinct for emotional

connection.
SubQuestion No : 50
Q.50 How is the passage structured?
Ans 1. A cause-effect explanation supported by a personal anecdote and scientific study
x 2. A fictional story followed by a list of symptoms
% 3. A debate between two opposing views on yawning

x 4. A sequence of unrelated facts about yawning

Section : General Hindi and Comprehension
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Comprehension:

2 e DI YgHR YL IV G & IR Il
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Comprehension:

2 e Bl UGHR g 70 Ul & IR < :
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B &, I 3 & G 7SR 371 @I &1 APBR B &H &1l & 7d ¢, Fofi-oft Fu ar R off
T TPTd &1 S ST PI PHARI & AHSH AR, FifP BH BT weferdr bl H 781, FHud 7 ¢;
39 g5uTe H § S Ush-Ueh BGH ol Ifd, Uh-Uh &9 bl QIS &I G oidl ¢l dIRdd H 9¢Ts & 9dd
BT G HY-3T9H & g1 H3T @ 1 37! it BT D15 I el | 77 S & 0 @ 1 Ig fopaht
ol 37991 & Ig HIWT &l BR bl b 379 3 b foTU BIS 3Tl 8l 38 IS &'

SubQuestion No : 57

Q.57 U¥dd e BT ST A9 & -

Ans 1. BHA 3§ DI AT
X 2. PHARA & 1 &Y g7
x 3. 99d frER &1 g9
X 4. 78T BIg Al
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Comprehension:

2 e DI YgHR YL IV G & IR Il
'THR U BT SARAI b YR Jdg a1 Higd aid &1 ¥ b HicIAfSd ydd-fAER 6 dvg d gARl
3! B FH1 S € 3R SRa g8 o 3R WiHd €1 7R Bid & g1 39 b uge Bl BIfer
B &, I 3N & G AR 371 @A &1 APB HBIR &H &1 &1 71d ¢, oft-soft Fu It R off
T DT &1 2 ST B FHIN & THSHT AR, R B B Wefardl Bt § e, HHuadT | §;
39 g5uTe H § S Ush-Udh BGH ol Ifd, Uh-Uh &9 Pl TeIs &I G oidl ¢l dIkdd § T¢Ts & Udd
BT G HY-3T9H & 21 H31 & 15 37! T BT BIg M el | 77 Siia & 0 @ 1 Ig fopaht
off 3raReT & 98 3199 T8 B Tl b 319 3P AT HIE 319 a1 78 38 78 !
SubQuestion No : 58

Q.58 U¥dd eiel b W & -

Ans x 1. faquunars

@ 2. WTaTcHe
x 3. RATHS
X 4. BIATHB

Comprehension:
S e BT YD YL IV G &b IR IS0
AR AT T SHARCI & Fex G b Higs aid &1 5Y & HeAHSd Iad-RIER &I %8 9 gAY
AR & A1 A & 3R SR 87 39 AR Had €1 PR Sia € 8 374 e uga 1 Bifier
BA &, I 31 & G ASR T T &1 APB PR &7 &Il & 7d &, PAl-Hoft U Tl IR off
T T &1 9 ST T FHINI & THSHT AR, RAfep B BT Aefapdl Bl § e, SHUAAT | &;
3 P91 ¢ 511 Uh-Ub PbaH Pl I1fd, Ueb-Ush &1 bl TGS bl TG oid &l dIkdd H TGS &b Udd
BT GG 3794-H19H & ST 11T & fob 3TPI It DY bIg AT el | 7 Sita- & U1 & 13 ag fopeit
ol 37aReT § g AW el B Abd b 39 3P foIU BIg 3ILIHT el I8 I8 &l
SubQuestion No : 59
Q.59 U] i ¥ g1 U &l A & -
Ans 1. PRI
X 2. 3 BT TR ST
X 3. 37191 &1 &fT0T 81T
X 4. 3T BT QR A &l
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Comprehension:

2 e B UgHR I8 70 Ul & IR AT

'THIR U BT SARGI b Ye? Jdg a1 Higd ad &1 ¥ & HicIAfSd gdd-fAaR & dvg 9 gARl
3Gl B FA1 S € 3R SRe g8 oA 3R WA &1 7R Bid & g1 39 e qge Bl BIfer
B &, I 3 & G SR 37 @A &1 APBI HBIR &H &1 &1 71d ¢, oft-soft Fu It R off
eI T &1 S ST B BN & THSHI AT, i H Y Arefebd bl § 781, B 1 ¢;
39 g5uTe H § ST Ush-Udh bGH bl I1fd, Uh-Ub &9 Pl FgIe Bl 3G oidl &l dkdd H 9¢Ts & Udd
BT W HY-3T9H & g1 H31 & 13 37! it BT D15 I el | 77 Siia & 01 @ 1 Ig fopaht
ofl 37aReT ¥ g UG &l B Abdl b 319 3P oIV BIg 3ILIHT el I8 T8 &l

SubQuestion No : 60
0.60 U3dd &y ¥ ygh WeAufa &1 A & -
Ans x1.ﬁ@f@f‘1¥fﬂ§3ﬂ
x 2. ied A et g3
x 3. e J & g3
v 4. e A 39T g3

0.61 MS Word & ®19-1T fabed IR &I YdieiRd 3MseR &1 fore fbue S 61 Jfaer adi
¢, o o &R 9k 3% Y 213 fU faAr1 dIR-9IR Siagie § g0¢ &R Abd 8?

Ans x 1. 3¥cl-BiAC (AutoFormat)
x 2. 3{121-®BYae (AutoCorrect)
» 3. [d® ured (Quick Parts)
x 4. 3CI-¢RE (AutoText)

0.62 fHfafEd & J $17-I1 faw ey, 3TAPTEd! S vHU yravuise & offav M faea 3mé (Clip
Art) I B3 b e ar g2

Ans x 1. Design > Slide Size
X 2. Home > Find
x 3. View > Notes Page

« 4. Insert > Online Pictures
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Q.63 $¢5i f32@e RAREH (Intrusion Detection System - IDS) ®T bRl T 8IdT 82

Ans 1. A9IfAA JREM Iecig-l Bl gal AT 3R GLAD! Bl 3l BRAT

x 2. 321 &1 &I APl
x 3. JdcAelte 827 Uf~he &Rl
x 4. 9¢d% ¢fthe Yafdd B3l

0.64 fgfafad § d ®17-A1 318, MS-Word & 3udi<eHgl aidr &2
Ans x 1.8 (Italic)

x 2. §1e8 (Bold)

& 3 oo ¢l (Magic tool)

x 4. 3783189 (Underline)

0.65 Fgfef@d ¥ d oI-3t db-ie, IR RN U B3 H db-1H B Vb YHTHE!
&7
Ans 1. STRIHC dRf%BBL (Document verification)
x 2. 3{12RT8319F (Authorisation)
x 3. fpEIIhI (Cryptography)

x 4. 319feb T (Authentication)

0.66 Modem &I Juf &Y T &2

Ans x 1. Modulator-Demultiplexer (HigeicR-feHeaRIR)
« 2. Modulator-Demodulator (Higeic3-fHig]cieR)
x 3. Multiplexer-Demultiplexer (Ao aRR-fSHE I IRTR)
x 4. Multiplexer-Demodulator (HeTieRiR-fEHig[cleR)

0.67 WIEHIA U ¢-hper ARH A (2FA) ST HIA BT MAMNS 1A T 82
Ans x 1.9¢l gS Uryas JJY
v 2. IS UpI & a5g R e oR

x 3. dal 0 WRHiRAY

x 4. JgAR I3 SH
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0.68 THUY URIe 2010 # HIEIST STACT dicd BT 3UAT HIb 10 F YN 8IBR 5 db dg dlell
H@N3M BT ATHH FA T T APl 82

Ans x 1. Formulas > Create Series > Set increment to 5
x 2. Data > Create Sequence > Step Value = 5, Starting Value = 10
« 3. Home > Fill > Series > Step Value = 5, Starting Value =10

x 4. Select the cells > Right-click > Series

0.69 fHferfEa & d oI=-J1 YIS AL 82
Ans  x 1. Y BaRM = Ctrl+C HIdls Qlicdhe

x 2. 0% B = Ctrl+V HIdIs Qiche

x 3. B¢ BaH = Ctrl+X HIars Qdcde

¢ 4. g BRI = Ctrl+U HIaIE Qfichpe

Q.70 SAA FMMSS HI3UIT I & fore foan 51 JFbar gl
Ans x 1. UHUY 98 Siagic &I Ufse
X 2. 3¢ TR UTSd

x 3. deTSe S1331

@ 4. S0 U1 3R U

Q.71 $8d & 95 (thread of emails) &1 30X &d AW ATHIIA: $AT YN1d f&AT SATAT &2
Ans x 1. 9l YA AI3A DY 3TR &, Mg 37! TP $o ot &
v 2. T Ha 2l & hact AT AP Bl 3gd B3

x 3. Tgu YT B & {10 HYUl Hef H2r Bl Iegd By
X 4. HoT Ja 8TV 3R 7 98 Y& B
Q.72 &l 0A Afh P $A A5 & fev 31t 'To' A1 'Cc’ fove ¥ A &, ok &) fFmforfEa 7 3
®I-9T1 fabey 41 @2
Ans x 1.Reply
« 2. Forward
x 3. Reply All

x 4. Resend
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Q.73 HIgHINITR q3 ¥ fHdfl Siqgie Pl Pl B &I Al &1 FAgfaf@d ¥ d o14-a1 e
el 82

Ans 1. Ctrl+C 99 &3l
x 2. BRI EU B IR AT Hellst 929 (X) TR faeld B0
x 3. BIgcl A A 'Close’ @I RIcipe BT

x 4. Ctrl+W 9 &30

0.74 30 NI SIS Hd I9I, IS ¥ 3¢9 & ®Y H grsifcid 308 B34 & fav
fafafad & d fey HI-91S didhe BT 39ANT fHAT STdT 82

Ans 1. Ctrl+K
x 2.Ctrl +L
x 3. Ctrl + Shift + 2

x 4. Ctrl + |

Q.75 SI35R BISIBY (Vb SRR dIARV) & Hde T el B b1 94 HIfSU|

Ans 1. I8 IRRY 9 135K JR& TR EHA Bl &, (ST &bR d9-Usil H gUiaATYUl Big IT Felee-
188 RBIET (malicious code or client-side scripting) STe & J&MH &l 37T &l

X 2. I U 318 WA SRR IR H I UP g1 Ig BIecll Bl Gield & 3¢ 3RS B adl
g 31k e ae1 Jead X Fsh I Hel b &l

x 3.3 A WA g & RIfp I AUl LR ATeb Bl I3 A8 A W B Jbd gl
x 4. 398 UgaR off &1 TahdT & 311 374ifed Uig-379 37R sy 349 &l ol
0.76 5T YBR B YR dIARY, A icTHe S AN A betdl & 31 3097 fFU A W
SR B AhMd Hdl 82
Ans 1. 8% aR—RA (Macro Virus)
x 2. clifsi® §7 (Logic Bomb)
x 3. 215 81 (Trojan Horse)
x 4. 99 (Worm)
Q.77 UHUH URId | U &l abqd &I Bl 31 ofic 7 16l A & vgw o34 & fav Fufaf@d
T f6U B &1 39T fBaT J1dr 82
Ans x 1.Sheet address!Cell column
% 2. Sheet address!Cell address
x 3. Sheet row!Cell address

« 4. Sheet name!Cell address
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Q.78 UNUY YTaRyige 3¢ oM ¥ insert Date and Time & 3ia*fd fAyferfad & I &19-11 fadey
Hisge T8l & g?
Ans x 1. Fixed
X 2. Language
x 3. Update automatically

« 4. Update by user

Q.79 IfE g1 MS a5 | 431 RIATH Y& BT fa1 2HHE 61 U S ellsd & BT A18d &, dl
S1-Aft ST ST 3UAT fHAT S/TAT 82

Ans 1. Shift + Enter
x 2.Tab
x 3. Enter
x 4. Shift + Tab

0.80 MS UTdRUige 188 & dHAUT3S H ok WA & forv, fFAgfarad & § oi9-11 fawey Biffe
d%A1338 (Format Background) AR & 3idfd 3uf@&d =&l giar &2

Ans 1. Image fill
X 2. Texture fill
X 3. Solid fill
X 4. Gradient fill
Q.81 A ot &1H @Y 12 &A1 H T B AT & 3R B 31 B9 & 16 &A1 7 Q1 B Al &
Ifg d Gl eI 3 & B1H &I, dl fd-T &1H Ay I ATTI?

Ans x1.i
48

x2.i
48

x3.i
16

va 2
16
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0.82 314 ¥ 12 a¥ q1g ST b1 31 40 a¥ gfl | A, Feg-1 I 7 9 St &1 FAfd 3R d=a
&Y I HI 31 $T 379Td 3 : 5 8110 9 ygal 99 61 Ay fHa-h A2

Ans x1.26aY
x2.23 99
x 3.24 a4
v 4. 25T

0.83 el 3t 3 F A y% $ 99d BT adl &1 I 3P AT 30% H G AN R =T A
25% $1 gfg rdl &, A 3US! a9d & 40% & qfG ardl &1 y &1 711 A1d HIfSI (et
& &I W1l d® yuitfed)

Ans x1.3523
x 2.25.25
v 3.3333

x 4.42.25

0.84 6.5,10.6, 19.7 3R a &1 3RId 13 &1 a &I #I1 FId S|
Ans x1.14.2
v2.152
x3.17.2
x 4.16.2
Q.85 Y0 bI adard Y 30 17 a1 HI 31 & J1 I ofi A1 81 25 99 91, 3P 1Y
ISP S=l B MY S AT S SRR aldft | IR B g 71T 301y ard Hif3e|
Ans 1.75a9
x 2.55dY
x 3.65dY
x 4.85dY

0.86 UTd J&AT3M BT APTHA 655 &1 Ugell & JSA3N &1 31Td 76 & 3R A Jw=ar 113 g1 A9
&l Y13t &7 3d sitd HIf3r|

Ans »1.195
x 2.189
x 3.196

x 4.190
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Q.87 U Hfgell AR 3ifPd Jed IR 40% b G Adl &, BRIP SR 3 16% 61 @I gl &
If& 98 3ifPHd oI U 20% B §e UR I9d1 &, dl 39 b ufdad oy ar gify a2

Ans x1.12% @
x 2.10% YT
o 3. 12% @Y

x 4.10% &If9

Q.88 QI 3uficar] & o9 gU I1d ¥, 4sfigpd Adardi3 § & 95% Adardr3i 3 39 dd STall 31
STl 9T¢ 7l # & 20% Ad 1de YU 70| fysr=ft Inficar &t de 7di 7 d 55% dd et 3R
39 1976 Hdl & 3id? A 14 Sfid feran| feda adcrar ysfigd 4?2

Ans . 1.26000
x 2.25997
X 3.26001
x 4.26002

Q.89 U gGHIaR & UIH U PBIPI AT &1 B 2024 § 5500 @i didbelc Sl IS A1d 2024
7§t 718 gic didcle ) IS 6% &1 i1 ATd 2024 & fHdi gic didde dadi 75?2

Ans x1.5280
x 2.5720
v 3.5170

x 4. 5550

0.90 d19® & dd- H Ugel 40% b1 qfg & 718, 6 35% $I Bl $I 718 3R R 25% $I 3G
61 S| 3P dd 7 ¢ aRad sird Hifsel

Ans  x 1.12.25% 5!
v 2.13.75% dfg
x 3. M% 3fg

x 4.13% BHl
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0.91 U IATAfIH J&T H, U &b ¢ oI 2 3”1, A 3R B, U A1 ATYT &1 391 2 ursuf
aIR1 3MYfef fpU sird & 3t & 1 HHE 30 3R 20 A ¥ R DA &1 U AT Uiy 4
efier ufd fFe &Y &3 A o A figror & Sirdr 81 il arsy ve a1y o1 &3d gu & @l 15
e ¥ R TP ad g1 &b I eniar (efte? #) srd Hifse?

Ans x1.420
x 2.120
& 3. 240

x 4.360

0.92 28 x 2 x 585 +~ V2025 = y + 703 P AT B dlel y BT A lTd HIfre
Ans x1.30

x 2.24

x 3.16

v4.25

0.93 f&U U A3T& &I 414 slid HIfIv]

0.92 x 0.92 - 0.08 x 0.08
Ans x 1.1
v 2.0.84
x 3.0.08

x 4.0.92

0.94 fgferfad MBI &1 719 siid HIfSIv]
o {10}
83—5~'+(?) -7+4X2
Ans x1.494
x 2.495
x 3.500

v 4.492
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Q.95 50 ¥l $I 43 Yed, 34 [Idb] & HI Yed b SRR ¢l g1 A1 &1 gfderd sird
$Ifrel

Ans .30, B

100
)(’2. 0, E‘»Tﬁ
16 &

100
x 3. 100, ey
16 %

x 4.3720, Y

0.96 U IpcR dlcld 3 HE dP 42 km/hr 61 1l A 3R 2 9 d&b 48 km/hr B dred I I1AT
Bl &1 ¥PpeR Al I 3Ad ATl (km/hr /) STd B0

Ans x1.438
x2.449
& 3. 444

x 4.432

0.97 &R 3ie H 1 A1d 61 a1l 10 km/hr 8, 31€P Al 2 km/hr &1 TTel & Yaifed @ @ 21
eRT 1 faudid fegem ¥ ve AfYd gt 98 &3 o 1 arelt J93, o7 &1 fgom & Jar9 o
I B3 | A arel 999 A 5 €2 371S 81 g ard Hifsrey

Ans 1.120 km
x 2.110 km
x 3.100 km

x 4.130 km

0.98 1014+ V96+ V54— V862 Pl W FIfSrel

Ans 41 g6
X2 10v6
X 3. 6vVE
x4 5E
0.99 U® Hf3i Ae bl Yol BIAd 8,100 &1 $AB! HIAd I 20% H g 6 Sirdl 8 3R B
3T 25% B gfg B STl &1 =JfSi Ae $ A Hiud ( ) 9rd Hifsiel
Ans x1.7400
X 2.7,600
v 3.8,100

x 4.8,600



https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap

Adda

Ans

=&

7

x 1.31,453.50
v 2.31,53333
x 3.%1,633.00

x 4.31,733.40

0.100 s T &1 eI ¥2,300 3ifd &1 Vb gPHIaIR 3HfHd eI U 20% Bl §e a1 & dIg
20% BT @1 Affd ST &1 PHT BT Yo STd ST (S Gl 2T dB Fal) |

GET IT ON
Google Play
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